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Üldist 

Kasutamisviisid 
single-user setup — andmebaasid on arvutis (lokaalterminibaas, local termbase) 
multi-user setups — andmebaasid on võrguserveris (remote database) 

MultiTerm versioonid 
MT 2007 järjekorranumbriga 7.5. MT 2007 on saadav erinevates versioonides: 
SDL MultiTerm Desktop — single-user setup. Sisaldab: MultiTerm ja MultiTerm 
Convert. MultiTerm Extract ja PhraseFinder on saadavad valikuna. 
SDL MultiTerm Team — väikeste meeskondade jaoks. Andmebaasid salvestatakse 
tsentraalselt. Sisaldab: MultiTerm Online, MultiTerm Anywhere, MultiTerm Report ja 
MultiTerm Server Console. 
SDL MultiTerm Server — multi-user setup. Kliendiserveri rakendus, kasutajate (e. 
klientide) arvult piiramatu. Andmebaasid salvestatakse tsentraalselt. Sisaldab: 
MultiTerm Server, MultiTerm Online, MultiTerm Anywhere, MultiTerm Report ja 
MultiTerm Server Console. MultiTerm Extract ja PhraseFinder on saadavad valikuna. 

Varasemad MT versioonid 
MT 2007 võib olla ühes arvutis koos MT 5.x ja MT ’95 versioonidega. 
MT 2007 ja 6.x ei saa olla ühes arvutis samaaegselt installeeritud! 6.x terminibaasi ei 
saa avada kohe MT 2007-s, need tuleb eksportida MDB-failina ning importida uude 
versiooni. 
5.x. terminibaasi (*.mtw) tuleb konverteerida MultiTerm Convert’i abil. 

MT komponendid 
MultiTerm — põhiline programm terminoloogia haldamiseks. 
MultiTerm Administrator — klienditarkvara kasutajate ja andmebaaside haldamiseks 
mulit-user setup’is. Kasutusõigusi saab määrata ainult administraator. 
MultiTerm Convert — konverteerib andmebaase vanast MultiTermist. Samuti toetab 
failiformaate (*.xls), (*.txt) ja (*.csv). 
MultiTerm Extract ja PhraseFinder — terminoloogia automaatne „väljatõmbamine“ 
erinevatest tekstiformaatidest ning eksportimine MT-sse. MT Extract’il ja SDL 
PhraseFinder’il on erinevad meetodid terminoloogia tuvastamiseks. Lisainfo: 
MultiTerm Extract Tools Guide. 
MultiTerm Online Web Interface — sissepääs terminoloogiasse veebi kaudu. 
Veebisõnastik luuakse MultiTerm Online web server’i tarkvara abil.  

Formaadid 
MultiTerm 2007 andmebaasi formaat on *.mdb. Ekspordiks kasutatakse XML või muud 
formaati. 
MT ’95 Plus / MT 5.x on *.mtw-formaadis. Ekspordiks kasutatakse ainult txt-formaati. 
Vanemaid MT andmebaase (*.mtw) on võimalik konverteerida XML-i MultiTerm 
Convert’i abil. MultiTerm Convert konverteerib samuti Microsoft Excel’ist (*.xls) ning 
andmebaasivahelistest formaatidest (*.txt) ja (*.csv). 

Andmebaasi komponendid ja ülesehitus 
Termbase Entries (terminibaasi kirjed). Kirje (entry) sisaldab min. 1 terminit. 
Tüüpiline kirje on sõna ja selle tõlked erinevates keeltes, lisainfo terve kirje või üksiku 
termini kohta. 
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Termbase Fields — sisaldavad terminoloogiat ja infot. 
Index fields (indeksväljad) — sisaldavad termineid. 1 indeksväli = 1 keel. Otsing 
teostatakse lähteindeksist (lähtekeelest).  
Descriptive fields (kirjeldusväljad) — lisainfo kogu kirjest või üksikust terminist. Võib 
olla teksti, valikloendi, arvu, multimeedia faili vms kujul.  
Entry class field (kirje klass) — ainult võrguandmebaasides. 
System and history fields — automaatne info kirjest: kirje nr, millal ja kelle poolt 
loodud  ning millal ja kelle poolt muudetud. 

 
Terminibaasi definitsioon (termbase definition) (*.xdt) — määrab terminibaasi väljade  
tüübi (kohustuslik, kas väljas võib valida mitu mõistet), hierarhiat ja arvu igal tasandil. 
Definitsioon on iga terminibaasi fundamentaalne koostisosa. 
 
Kirjete struktuur on hierarhiline: 
Kirje tasand (entry level) — sisaldab süsteemseid väljasid ning kirje kirjeldusvälju. 
 Indeksi tasand (index level) — sisaldab terminit ning indeksi kirjeldusvälju. 
  Termini tasand (term level) — sisaldab antud termini kirjeldusvälju. 
 
Termibaasi objektid 
baseeruvad terminibaasi definitsioonile ja on järgmised: 
 Filter (*.xdf) — filter, mida saab kasutada otsingus, impordis ja ekspordis. 
 Layout (*.xdl) — kirjete väljanägemise parameetrid. 
 Input model (*.xdm) — mall (template) kirjete loomiseks ja toimetamiseks. 
 Import definition (*.xdi) — impordi parameetrid. 
 Export definition (*.xdx) — ekspordi parameetrid. 

Töö MultiTerm'i põhiprogrammiga 

Kasutajaliides, navigeerimine 
1. Ava MT. Vajadusel muuta kasutajanime: Termbase > Settings > Local user 
name. 
Kui on vaja logida võrguandmebaasi, kasuta Remote/Change Password. Local ja 
remote seadistused on teineteisest sõltumatud. 
2. Ava terminibaas (nt kaasas olev Local Sample): Termbase > Open/Close 
Termbases. 

2.1. Võrguandmebaasi avamine (ühendus MultiTerm Serveriga): 
a. Termbase > Login (>>More) 
b. username, password, MT Serveri nimi 
c. Vali Standard LAN või MultiTerm Anywhere sõltuvalt võrguühendusest 

arvuti ja MT Serveri vahel. 
d. vajadusel proxy-serveri aadress ja pordinumber. 
e. Ava terminibaas Termbase > Open/Close Termbases. 

3. Vali keelesuund (vastupidise suuna nupp ). 
Soovitatav on kasutada sama kasutajanime kohaliku ja võrguandmebaasi jaoks, et 
paremini jälgida oma tööd terminibaasiga. 
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Project Pane 
Vahekaart Hit List — otsingutulemused. Search > Search Settings max. arv. 
Vahekaart Favourites — sageli kasutatavad terminid projekti terminibaasides (Add 
Term to Favourites). 
Vahekaart Project — avatud terminibaasid. Sinine on vaikimisi terminibaas. (Set as 
Dafault Termbase). 
 
Browse Pane 
Näitab mingit terminit ja selle ümbritsevaid termineid. Sõnastiku sees saab liikuda 
noolklahvide, Pg Dn, Pg Up klahvide ning Alt+  ja Alt+  abil. 
 
Entry Pane 
Näitab kirjet, mis on valitud. Võib avada mitu terminit korraga (Open in a New Entry 
Tab). 
 
Navigeerimise viisid termibaasis: liikumine browse pane’is, otsing ja liikumine hit 
list’is, vahekaart Favourites ning sisemised viited (cross-references). 
 
Vaikimisi terminibaas (default termbase) 
Esimesena avatud terminibaas on alati vaikimisi e põhiline (default) (sinine). Kui on 
avatud mitu terminibaasi, toimub otsing alguses vaikimisi baasist, seejärel teistest 
(otsingu järjekord on baaside avamise järjekord). 
Hiire parem klikk Set as Deafult Termbase. 
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Termbase Catalogue koos terminibaasi objektidega 

Filtrid (*.xdf) 

Küljend (Layout) (*.xdl) 

Input Model (*.xdm) 

Import (*.xdi) 

Export (*.xdx) 

 
 
 
 
 
 
 

Projektid (*.xdp) 
 
 
 
 
 
 
 
 
 
 
 
 
 

Uue terminibaasi loomine 
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Töö terminibaasi definitsioonidega 
Terminibaasi definitsioone võib salvestada failina (.*xdt) edaspidiseks kasutamiseks, nt 
et taastada sama struktuuriga terminibaas muus kohas või kasutada neid mallina, et luua 
selle põhjal uut terminibaasi. 
Salvestamine: Termbase > Save Termbase Definition As 
Kasutamine teises terminibaasis: Termbase > Create Termbase, avaneb wizard, seal 
valida Load an existing termbase definition from file. Definitsioone võib täielikult 
üle võtta või muuta. 
Definitsiooni muutmine avatud vaikimisi (default) terminibaasis: Termbase > Modify 
Termbase Definition, vajutada „Next“ kuni ilmub lehekülg Index Fields. Võib lisada 
uusi indeks- ja kirjeldusvälju, lisada uusi valikloendi väärtusi, kustutada ja parandada 
olemasoleva valikloendi väärtusi, lisada uusi kirjeldusvälja kirjeid indeksi ja termini 
tasemel. Muudatuste tegemise järel vajutage Finish, misjärel kohaldatakse muudetud 
definitsioon terminibaasile. 

Lokaalandmebaaside vahetus kasutajate vahel 
Lokaalandmebaase saab liigutada kasutajate vahel kahel viisil: 

- Kui baas on MDB-formaadis: Termbase > Load External Termbase, seejärel  
Package/Delete Termbase. 

- Salvestada definitsioon *.xdt-faili (Save Termbase Definition As), seejärel 
eksportida terminibaasi *.xml-fail ja saata mõlemad failid teisele kasutajale, kes 
loob uut terminibaasi etteantud definitsiooniga ning impordib sisse *.xml-faili. 
NB! Sellisel viisil loodud terminibaas on originaalterminibaasi 1:1-koopia, välja 
arvatud kasutaja pool loodud terminibaasi objekte originaalterminibaasi 
kataloogis. Neid objekte tuleb salvestada ning seejärel üle viia teisse 
terminibaasi. 

Vaatame neid viise lähemalt. 

Load External Termbase ja Package/Delete Termbase 
See viis töötab ainult lokaalandmebaasidega formaadis *.mdb ning ei tööta 
võrguandmebaasidega, mis on salvestatud MultiTerm Serveris, Microsoft SQL serveris 
või Oracle serveris. 
1. Et avada mingit terminibaasi, vali Termbase > Load External Termbase ning 
näita MDB-faili asukohta. Kui terminibaas on üks kord alla laaditud, on see hiljem 
avamiseks kättesaav MultiTermis. 
NB! Mdb-fail kustutakse arvutist, kui terminibaas laaditakse MultiTermi (Load External 
Termbase)! 
 
2. Termbase name peab olema ainulaadne. Selle nime all esineb terminibaas 
MultiTermis. 
Termbase description ei ole kohustuslik täitmiseks. 
3. Vajuta OK. Alla laaditud terminibaas on nüüd kättesaadav avamiseks (Termbase > 
Open Termbase). 
 
4. Et lokaalterminibaasi salvestada MDB-failina või kustutada, vali Termbase > 
Package/Delete Termbase. 
 
Andmebaasi salvestamisel on soovitatav nimetada MDB-faili nii, nagu see on 
MultiTermis. 
Delete termbase permanently — kustutab terminibaasi faili. 
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Terminite import XML-failist 
 
 
 
 
 
 
 
 

Oma impordi definitsiooni loomine 
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Impordi definitsiooni salvestamine ja kasutamine 
 
 
 
 
 
 

Impordi definitsiooni muutus 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Otsing terminibaasides 

Üldine kirjeldus 
1. 
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2. Määra vaikimisi terminibaas. Teatud otsingu meetodeid (topelttermin, ebatäielik 
kirje, otsing kirje numbri järgi) võib rakendada ainult vaikimisi terminibaasi suhtes. 
3. Määra menüüs Project > Project Properties, millised terminibaasid antud projektis 
on otsingu jaoks lubatavad. Mittevajalike andmebaaside otsingust väljajätmine võib 
kiirendada otsingut ja parandada selle tulemusi. 
Kui otsing toimub mitmes terminibaasis, otsitakse esimesena vaikimisi baasist, seejärel 
läheb otsing järjekorras, mis on paika pandud Project Properties aknas, järjekorda saab 
muuta nuppudega Add ja Remove. 
4. Määra lähte- ja sihtkeel igas terminibaasis: Termbase > Termbase Catalogue > 
vahekaart General. Otsing toimub lähtekeelest (source language). 
5. Vajadusel rakenda filtrit igale terminibaasile. Et rakendada filtrit, tee terminibaas 
vaikimisi baasiks ning vali filter ülevalt rippmenüüst. 
6. Vajadusel muuta kirjete esitamise viisi (layout) igas terminibaasis. 
7. Määra menüüs Search > Search Settings otsingu tulemuste maksimaalne arv 
vahekaardil Hit List ja browse pane’is, kus ilmuvad otsingu tulemused. 
8. Samas menüüs määra otsingu viis, kui see toimub mitmest terminibaasist. 

Otsing mitmest terminibaasist 
Kui otsida mitmest terminibaasist korraga, kehtivad järgmised reeglid ja piirangud: 

- Võib kasutada ainult normaal-, täistekst- ning metamärgi otsingut. Ei saa otsida 
kirje numbri järgi, topelttermineid või ebatäielikke kirjeid. Neid meetodeid saab 
kasutada ainult default-terminibaasis. Detailsemalt vt peatükk Otsingu meetodid. 

- Iga terminibaasi jaoks võib rakendada oma otsingufiltrit. 
On olemas 3 seadistust otsinguks mitmest terminibaasist Termbase > Search Settings 

või nupp : 
Search termbases sequentially until a matching term is found — kõik terminibaasid 
otsitakse järjestikult läbi kuni vähemalt üks kirje on leitud või Hit List on täis. Kui 
midagi ei ole leitud 1. terminibaasist, otsitakse teisest jne. 
Search all termbases sequentially and group results by termbase — Hit List’is 
tulemused on esitatud tähestikulises järjekorras ning grupeeritud terminibaaside kaupa. 
Search all termbases in parallel and group results by term — samaaegne otsing 
kõikidest andmebaasides, Hit List’is on kõik tulemused esitatud tähestikulises 
järjekorras. Hägusotsingu puhul on esimesel kohal need terminid, mis langevad rohkem 
kokku. 
Kast Match Indexes — otsing toimub ainult terminibaasides samade indeksitega. See 
säästab aega, kui projektis on palju terminibaase erinevate keeltega. Kui see kast ei ole 
valitud, otsitakse kõik projekti andebaasid kõikides keeltes läbi. 

Otsingu meetodid 

 
Normal search — tavaline otsing täht tähe haaval, nt „apart“ leiab „apart“, 
„apartment“, „apartheid“. Tuleb määrata lähtekeel, kust otsida. 
Normal + Wildcard search — metamärkidena kasutatakse tärni (*), mis asendab 
ükskõik palju tähemärke või küsimärki (?), mis asendab ühte tähemärki. Metamärke 
saab kasutada igas positsioonis, ka mitu korraga, nt *apart*. 
Full Text search — otsing kõikides tekstiväljades (nt definitsioonis) kõikidest kirjetest 
kõikides keeltes. Tuleb sisestada vähemalt 3 tähemärki. 
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Fuzzy search — hägusotsing. Kasulik nt kui ei ole kindel termini kirjapildis. Tuleb 
sisestada vähemalt 3 tähemärki. Märkus: Hägusindeks uuendatakse pärast importi või  
termini lisamist/korrigeerimist. Kui hägusotsing on liiga aeglane, tuleb terminibaasi 
reorganiseerida Termbase > Reorganise Termbase. 
Search by entry number — otsib kirjet teatud numbriga. 
Duplicate term search — leiab topelttermineid. 
Incomplete entry search — leiab ebatäielikke kirju, mis ei vasta terminibaasi 
definitsioonile. Kasulik nt, kui on vajalik eristada täielikke ja ebatäielikke kirjeid. 

Ebatäielikud kirjed tekkivad kui: 
- need on loodud MS Wordis Quick Entry funktsiooni abil. 
- need on loodud TagEditoris Submit to MultiTerm funktsiooni abil. 
- need on loodud pärast importi. 
- need on loodud MultiTerm Extract'i abil. 

 
NB!  Entry number, duplicate term ja incomplete entry search’i ei saa kasutada mitme 
terminibaasi puhul. Otsitakse ainult default-terminibaasist. 
Kõiki otsingumeetodeid saab kombineerida filtritega, vt peatükk Filtrite kasutamine . 
Lisaks menüüs Search > Require Target Term võib seadistada, et leitud terminis 
oleks kindlasti tõlge sihtkeeles. Kui tõlget ei ole, siis terminit ei kuvata. 

Filtrite kasutamine terminibaasis ja otsingus 
Kui on rakendatud filter, näitab MultiTerm terminibaasi mitte tervikuna, vaid ainult 
neid kirjeid, mis vastavad filtri kriteeriumile. 
Filtrit võib nt kasutada, et leida kõiki kirjeid, mis olid loodud pärast teatud kuupäeva 
teatud kasutaja poolt. Töö filtreeritud kirjetega toimub analoogselt tööga terve 
andmebaasiga, nt otsing toimub filtreeritud tulemuste hulgast. 
MT-s on üks vaikimisi filter Source Contains Synonyms, mis lubab otsida termineid, 
mis sisaldavad mitu vastet vastavas lähtekeeles (source language). 
Filtrid on seotud kindla terminibaasiga. Nt kui projektis on avatud mitu terminibaasi, 
võib  igas neist olla omaette filter. Filter ei ole kohustuslik Kui default-terminibaasis 
rakendatakse filtrit, ei pea seda ilmtingimata ka teistes terminibaasides kasutama. 
Filtri rakendamine: 
1. Määra vaikimisi terminibaas. Vahekaart Project > Set as Default Termbase 
2. Vali vajalik filter rippmenüüst. 
3. Korda protseduuri teiste terminibaasidega. 
4. Kui kõik filtrid on paika pandud, määra lõplikult vaikimisi terminibaas. 

Leidmata terminite logimine 
Leidmata termineid saab kirjutada logifaili, et hiljem viia need terminibaasi sisse. 
Logifaili laiendus on *.msf, see asub samas kaustas projektiga, vaikimisi C:\Program 
Files\SDL International\MultiTerm 2007\. 
Et tundmatut terminit logida: 
1. Kui otsingu tulemus on „no terms“, vali Search > Log Search Term. 
2. Otsitav tundmatu sõna lisatakse logifaili koos sihtkeelega ning kasutajanimega. 
 

Kirjete loomine ning muutmine 

Uue kirje loomine: 
1. Vali küljendus (layout), mis näitab kõiki väljasid, mida soovid lisada. 
2. Vali Input Model menüüst Termbase > Termbase Catalogue. 
3. Entry > Add või [F3] või kasuta menüüriba. 
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Olemasoleva kirje muutmine: 
 
 
 
 
 
 
 

Sünonüümide järjekorra muutmine 
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Topelttermini tuvastamine 
 
 

Kirjete ühendamine 
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Kirjete eemaldamine 
 
 
 

Multimeedia faili lisamine ja eemaldamine 
 
 
 
 
 
 
 
 
 

Sisemiste viidete (cross-references) lisamine 
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Sisendmudelid (Input models) 

 

 

 

 

 

 

Sisendmudeli valimine (enne redigeerimist) 
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Sisendmudeli loomine 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



dmitri.platonov@gmail.com  

 - 20 - 

 
 
 
 

See lehekülg ei ole eelvaateks kättesaadav. 
Täiskonspekti ostmiseks võtke ühendust autoriga! 

dmitri.platonov@gmail.com 
 
 
 
 

Olemasolevate sisendmudelite salvestamine ja muutmine 
 
 
 
 
 
 

Kirjete kuvamine 
 
 
 
 
 
 

Uue küljendi (layout) loomine 
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Olemasoleva küljendi kasutamine 
 
 
 
 
 
 
 

Vaikimisi küljendid 
 
 
 
 
 
 
 
 
 
 
 



dmitri.platonov@gmail.com  

 - 23 - 

Olemasolevate küljendite salvestamine ja muutmine 
Küljendite muutmine ning vahetamine teiste kasutajatega sarnaneb teiste terminibaasi 
objektide kohtlemisega (nupud Save As, Load, Edit vahekaardil Layout). 
Küljendi faili laiend on XDL. 
 

Filtreerimine 
Filter on terminibaasi objekt, mis paneb paika terminibaasi otsingu, impordi ja ekspordi 
parameetrid. Nt otsingu käigus võib kasutada filtrit, et leida ainult neid kirjeid, mis oli 
loodud pärast teatud kuupäeva. 
Igas terminibaasis on üks vaikimisi filter Source Contains Synonyms. Kasutaja võib luua 
piiramatu arvu oma filtreid. 

Uue filtri loomine 
1. Ava vastav terminibaas ning määra see vaikimisi baasiks. 
2. Search > Filters või  Termbase > Termbase Catalogue > vahekaart Filter. 
3. Vajuta Create ja Next >. 
4. Sisesta filtri nime. Vajuta Next >. 
5. Aknas Filter Type vali filtri tüüp: 

Simple filter — filter ühe parameetriga, nt et leida kõiki kirjeid, mis on loodud 
teatud kasutaja poolt. 
Advanced filter — filter mitme parameetriga. Nt et leida kõiki kirjeid, mis on 
loodud teatud kasutaja poolt pärast mingit kuupäeva. 

5. Vajuta Next >. 
a. Kui oli valitud Simple Filter, ilmub järgmine dialoog: 

 
Vali vastav väli. 
Vali loogiline operaator: equal to, not equal to, less than, greater than, between, 
contains, doesn’t contain, is missing, is not missing (numbriväljad) või exact match,  
begins with, doesn't begin with, contains, doesn't contain, ends with, is missing, is not 
missing, has cross-references (tekstiväljad) ja has synonyms (indeksväljad). 
Apply on — See rippmenüü muutub aktiivseks, kui filtreerimiseks on valitud väli 
Term. Siin on kolm võimalust: 

Top — esimene termin indeksist. 
Synonyms — kõik teised terminid samast indeksist. 
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Olemasolevate filtrite kasutamine 
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Filtrite rakendamine terminibaasi otsingus 
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Filtrite rakendamine impordi definitsioonile 
 
 
 
 
 
 
 

Filtrite rakendamine ekspordi definitsioonile 
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Terminite eksport 
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Uue ekspordi definitsiooni loomine 
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Andmete eksport 
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Vaikimisi ekspordi definitsioonid 
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Olemasolevate ekspordi definitsioonide salvestamine ja 
muutmine 
 
 
 
 
 
 
 
 

Multimeedia failide eksport 
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Üksikkirje eksport 
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Andmebaasi haldamine 

 

Topeltterminid ning ebatäielikud kirjed 
 
 
 
 
 
 
 
 
 

Globaalsed muutused reimpordi abil 
 
 
 
 
 

Terminibaasi reorganisatsioon 

 

 

Terminibaasi varukoopia 
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MultiTerm ja MS Word 
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Enne töö algust 
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Otsing terminibaasist 
 
 
 
 
 
 
 
 
 
 
 

Filtri rakendamine terminibaasile 
 
 
 
 
 
 
 
 
 
 

Uue kirje lisamine Word'i kaudu 
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Terminite printimine Word’i kaudu 
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MultiTerm ja SDL Trados 

Ühenduse loomine MT ja Tradose vahel 
1. Käivita Translator’s Workbench (TWB). Vali Options > Term Recognition 
Options. 
2. Avatud dialoogis Terminology Recognition Options vahekaardil Termbase vali 
MulitTerm 7 väljas MultiTerm version. 
3. Menüüs Termbase location vajuta Browse, et avada dialoogi Open Termbases. 

 
4. Vajuta nuppu Add (+). Avaneb dialoog Select Termbases. 

 
5. Dialoogis Select Termbases vali lokaal- või võrguterminibaas. 
6. Dialoogis Open Termbases kontrolli valitud terminibaasi nimi ja asukoht, vajuta 
OK. 
7. Keelesuund Language selection peab vastama TWB keelesuunale. 
8. Vahekaardil Settings võib muuta terminite tuvastuse seadeid (Minimum match 
value ja Search depth). Võta üle vaikimisi seaded. 
9. Vajuta OK, et kinnitada terminibaasi seadeid ning siirduda tagasi TWB peaaknasse. 
10. Kontrolli, et TWB menüüs Option oleks märgitud funktsioon Term Recognition. 
(Ilmub lisaaken TWB-s). 
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MultiTerm ja TagEditor 
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MultiTerm TWB-s 
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MultiTerm Convert 
Konverteerib terminibaasi varasematest versioonidest uude XML-formaati. 
Toetatavad formaadid: MultiTerm ’95 ja MultiTerm 5 (*.mtw), andmebaasiformaadid 
*.xls, *txt, *csv, XML, SDL Termbase Desktop formaat *.tdb, SDL Termbase Online 
formaat *.mdb. 
TXT ja CSV failid peavad olema UTF-8 kodeeringus (Save As…/Encoding). 
Konverteerimise protsessi sammud sõltuvad sellest, millisest formaadist terminibaasi 
konverteeritakse. 
 
Üldkuju: 
1. Käivita MT Convert. Vajadusel märgi, et salvestada konverteerimise parameetreid. 
2. Vali millisest formaadist tuleb konverteerida (nt Excelist). 
3. Vali konverteeritav fail (input file) 
4. Määra, millised väljad on indeks- ja millised kirjeldusväljad. 
5. Määra kirje struktuur (nt termin + allikas + kommentaar + kommentaari allikas). 
6. Konverteeri. 
Konverteerimise käigus luuakse 3 faili: 

*.xdt – sisaldab termibaasi definitsioone 
*.xml – sisaldab termineid, kirjeid. 
*.log – logifail 

7. Loo uus terminibaas saadud xdt-faili alusel. 
8. Impordi saadud xml-fail kirjetega MultiTermi. Kasuta Default import definition’it. 
 

Nõuanded 
 Faili nimes (sh objektide failis) ei tohiks olla täppi- jms tähte (ä, õ, å jne). 
 1 mõiste = 1 kirje. 
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